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This is a fully assembled and tested K164 with one 16K (1 x 16K) of EEPROM memory installed. 
 
The documentation for the kit form of K164 is given on the following pages. Please read it first to 
get an overview of how the kit works. 
 
Instal our own terminal program ‘term.exe’ or any other terminal program. (Details are given below 
on where to get it and how to set it up.) Connect a 9 pin serial straight-through cable to the K164. 
Connect a 9V – 12V power supply. The following should appear on your screen: 
 

Telephone Call Logger V1.9  (16K) 
 

Ready 
 
Press ‘Enter’ and  
 
  Password? 
 
will appear on the screen. Enter 11111 the password I used when I tested the unit and press Enter. 
The Menu should appear. 
 
If you press ‘1’ then you may see the approximate time and date with the data I used to test it. Reset 
the time and date. Change the password. 
 
There is a 3V CR2032 battery already in the kit which is why the data has been preserved. 
 
I set the switch to record all calls. If you only want to record the outgoing calls then you will have 
to undo the two screw under the case and switch the switch. 
 
If you forget the password you will also have to open the case and depress the tact switch while you 
simultaneously press Enter. 
 
So press option 2 and clear out the old data. Connect the Line and Phone and lift the handset. The 
time and date should appear on the screen. Press some buttons. They will appear on the screen. 
Replace the handset. The time and date will appear. 
 
Now you can disconnect the connection to the PC. All lifts of the handset and telephone numbers 
pressed will be recorded. Also the time of incoming calls will be recorded but not the number which 
is calling you. 
 
You may install an additional 3 x 16K memory chips. We can supply them if you cannot buy 
locally. 
 
If you have technical questions email   frank@ozitronics.com 
 
March 15, 2004. 
Hong Kong. 
peterhk@kitsrus.com
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INTRODUCTION 
Have you ever opened your phone bill and thought “I 
can’t have made so many calls”. Most phone bills 
itemize long distance calls and give details of the 
number dialled. But local calls are just totalled up - you 
have no way of knowing who those calls were made to. 
 
What about small businesses that operate from home? 
They can usually claim a percentage of phone calls for 
income tax purposes. With the call logger, ALL calls 
are recorded and it is simply a matter of sorting them to 
determine how many were business calls. And it all 
happens automatically. Only DTMF tone dialing is 
supported. 
 
The logger records the start and stop time of ALL 
outgoing calls along with the number dialled (plus any 
other digits pressed during the call). It operates “stand 
alone” – no need for any connection to a PC. 
 
Telephone call data is output in a format that can be 
easily imported into Microsoft Excel. Various Excel 
functions can then be used to analyze and sort the data 
and produce formatted printouts. 
 
Data is stored in non-volatile EEPROM memory, so 
there is no loss of data in the event of a power failure. 
The kit is supplied with 16K of memory and is 
expandable in 16K blocks up to 64K total. The kit 
“auto detects” the amount of available memory – just 
plug it in and go. 
 
The number of calls that can be recorded depends on 
the amount of memory installed and the number 
dialled. Each call requires the following minimum 
number of bytes: 
 

• Start date & time - 6 bytes 
• Stop data & time - 6 bytes 
• Record terminator - 1 byte 

 
Each digit dialled requires one byte. So, each call 
occupies 13 bytes of memory PLUS one byte for each 
digit dialled. Allowing for 11 bytes of system overhead 
(password storage) this leaves  711 x 10-digit phone 
numbers that can be stored in the basic kit with 16K of 
memory installed [(16384-11)/23] bytes.) With the 
full 64K memory installed this is 2848x10-digit 
phone numbers. Ten digits is just taken as an 
example. If you are in a country where only 7 or 8 
digits are used per call then you will get more calls 
stored. If you pay your bills by credit card then about 
50 to 55 bytes will be used per call. 
 
Access to all logger functions, including downloading 
of call data, is password protected. 
 
Three LEDs are provided on the front panel to indicate 
power on, offhook (call in progress) and memory 
status. The memory status LED flashes when the 

memory is 75% full and is permanently on when 100% 
full. 
 
As a bonus, call data is also output in “real time” to the 
serial port as well as being recorded in memory. This is 
useful when immediate call analysis and/or external 
data logging is required. This “real time” output is 
unaffected by the memory status – even if the memory 
is full the call data is still output. You can attach this 
serial output to the parallel port of a printer by going 
through a serial to parallel converter. These interface 
boards are readily available commercially. (The 
‘logged’ data is displayed in a slightly different format 
to the ‘real time’ date. Logged data is displayed ‘Start 
date/time, End date/time, digits dialed.’ Real time dats 
is displayed ‘Start date time, digits dialed, end 
date/time.’ The actual data is the same.)  
 
Two RJ12 (USA-type) telephone sockets are available 
on the rear panel, marked “LINE” and “PHONE”. The 
telephone line connects to the “LINE” connector and 
an optional telephone can be connected to the 
“PHONE” connector. This allows a telephone to be 
connected and used even when the logger is put in its 
place. Telephone line cords are not supplied with 
the logger. 
 
The kit is constructed on a double-sided, through hole 
plated printed circuit board (PCB) and fits in a plastic 
case measuring 130(W) x 100(D) x 30(H)mm. Screen-
printed front and rear panels are supplied.  
 
The kit requires a 9-to-12V DC power supply. A 
12VDC wall adaptor rated at 300mA is suitable. 
 
ASSEMBLY INSTRUCTIONS 
Use the component overlay on the PCB to place the 
components in the following order. Leave the LEDs 
until final assembly. 
1. Resistors and diodes. Put in the four 1% metal film 

resistors around the DTMF decoder first. R3-6. 
2. IC sockets 
3. Crystals and capacitors. Use a resistor lead offcut 

to hold down crystal Y3 against the PCB. 
4. Transistors and the two switches 
5. Battery holder and diode bridges 
6. DC Jack and D9 connector 
7. Both telephone connectors 
8. Metal Oxide Varistor (MOV). Push this as far 

down onto the PCB as possible. It is tall and might 
need to be pushed right in so the lid will fit. 

 
Do not insert any ICs yet. 
 
The plastic box is in two halves. Take the bottom half 
and fit the rear panel into the slot provided. Now drop 
in the PCB and slide it back so that the telephone and 
D9 connectors protrude through the panel. Fix the PCB 
into place using the four self tapping screws provided. 
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Now comes assembly of the front panel. Start by 
inserting the three LED clips into the holes, pushing 
them in from the front. Now insert the LEDS into the 
clips from the rear. The LEDs should “click” into 
place.  
 
Turn the LEDs in the clips so that the long lead is to 
the left when viewed from the front. This means that 
the flat edge of the LED (short lead, cathode) will be 
to the right when viewed from the front and will 
correspond to the flat marked on the PCB overlay. This 
is very important so make sure it is right. Now bend 
the leads down at right angles, about 3mm from the 
LED body, as shown below. Use a pair of long nose 
pliers to hold the leads while bending. Cut the leads off 
to a length of about 9mm from the bend. 

 
Position the front panel on to the case and drop it into 
place, making sure that the LED leads are inserted into 
their matching holes on the PCB. Once the panel is in 
place solder the LED leads from the top of the PCB. 
 
Insert the 5V regulator IC, U2 (MAX666), into its 
socket. Connect a power supply to the DC jack. The 
power LED on the front panel should light. Measure 
the DC voltage output of the regulator. Easiest place to 
do this is to measure across pins 10 (GND) and 20 (+5) 
of the U3 IC socket. It should read 5 volts.  
 
If OK disconnect the power and insert the rest of the 
ICs. Take care that the ICs are the correct way around 
and none of the leads are bent under the body of the IC. 
 
The EEPROM (24C128) must be inserted in position 
‘MEM 1’ (U4). Any extra EEPROMs must be inserted 
in order from left to right starting at ‘MEM 2’ (U5). 
The DS1307 clock/calendar chip, U8, is located to the 
left of all the EEPROMs. The lithium battery is 
inserted in the battery holder with the positive side up. 
Note we have not supplied a battery because fresh 
CR2032 batteries are readily available everywhere. We 
do not want to supply kits with flat batteries. 
 
Do not fit the plastic case lid just yet. Proceed to the 
section “INSTALLATION AND SETUP”. Now fit the 
plastic case lid and secure it in place. 
 
CIRCUIT DESCRIPTION 
The kit is controlled by U3, a preprogrammed  
89C2051 micro-controller from Atmel. This was 
chosen because it has the required number of I/O pins 
and a built in serial port. It has 2K bytes of flash 
memory which is pre-programmed with the control 
firmware. 
 
U2, a Maxim MAX666, provides two functions: 
 
1. 5V regulator (via pin 2) to power the rest of the 

circuitry. The diode bridge B1 provides polarity 

protection. The MAX666 maximum input voltage 
is 16.5 volts. Some 12V (nominal) plug packs 
actually output a lot higher voltage at low output 
currents, up to 17V in some cases. Diodes D1 & 2, 
along with B1, allows voltages up to 18.9V to be 
used to power the kit. 

2. Low Battery Detect, intended for use with battery 
powered equipment. In this application it is used to 
detect when the telephone line is ‘looped’ (in use). 
The DC voltage of a telephone line is nominally 
48 volts. This drops to around 12 volts or less 
when looped. The chip detects this voltage drop 
and pulls pin 7 low. Diode bridge B2 provides 
polarity protection on the telephone line. 

 
U1 (MT8870) is a DTMF decoder. It connects to the 
telephone line via resistors R1 and R2 and capacitors 
C1 and C2. When a DTMF tone is detected, pin 15 
goes high and the 4-bit digit data is presented on pins 
11-14. The metal oxide varistor (MOV) protects the kit 
from damage by any short duration high voltage spikes 
on the telephone line. 
 
All clock/calendar functions are provided by U8 
(DS1307), a Serial Real Time Clock from Dallas 
Semiconductor. It uses a 2 wire I2C serial interface to 
communicate with the microcontroller. It features real 
time clock counts for seconds, minutes, hours, date of 
the month, month, day of the week and year with leap 
year compensation valid until 2100. It has a square 
wave output (pin 7), programmed to give a 1 second 
signal. This is used by the microcontroller firmware to 
flash the memory status LED. The chip also features 
automatic power-fail detect and switch circuitry. The 
3V lithium battery provides backup power during a 
power failure. 
 
Non-volatile memory storage is provided by up to four 
AT24C128 EEPROMs, U4 to U7. These also use a 2 
wire I2C serial interface like the clock chip. The 
EEPROMs are 128K bit types organised as 16K x 8. At 
least one EEPROM (U4) must be present. The rest are 
optional and can be inserted in sequence by the user as 
required. 
 
Two switches are provided. S1 is a pushbutton type 
and is used for ‘password bypass’. S2 is a slide switch 
and is used to set the type of calls recorded. More on 
these later. 
 
The serial interface is a bit unusual. It is not the regular 
type offering RS232 type signal levels. Instead we 
have used two high-speed opto-isolators, U9 and U10. 
These were necessary to provide complete electrical 
isolation between any PC connected to the serial port 
and the telephone line. 
 
An RS232 interface uses a common ‘ground’ signal 
between each end of the interface. At the PC end this 
‘ground’ signal is connected to mains earth. This mains 
earth would then be connected to the telephone line via 
on-board circuitry in the data logger. Since both sides 
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of a telephone line are normally ‘floating’ above earth, 
earthing one side of the line would cause a fault 
condition at the telephone exchange and the line would 
stop working properly. 
 
The solution is to use an opto-isolated serial port for 
connection to a PC. Otherwise the kit would have to be 
disconnected from the phone line BEFORE connecting 
a PC to it. It would also mean that a PC could not be 
permanently connected to capture the ‘real time’ output 
from the logger. 
The receive side of the serial interface (U9) is simple. 
The RS232 voltage levels from the PC drive the LED 
in U9 via R24. Diode D3 protects the LED from 
reverse currents when the RS232 level goes negative. 
 
The transmit side of the serial interface (U10) requires 
a positive voltage to bias the output transistor. To 
maintain electrical isolation, this voltage is provided by 
the PC side of the interface via the DTR line. The 
‘active’ state of DTR is +12V (nominal).R23 is the 
collector load resistor for U10’s open-collector output, 
while R25 provides bias for the Darlington output 
stage, reducing the turn-off time of the output. 
 
What about the power supply you say? Yes, it also 
must be isolated from mains earth. This is not really a 
problem when using a plug pack. Plug packs normally 
use a 2-pin connection to mains (no earth pin). They 
also use a transformer to convert the mains voltage, 
which provides further electrical isolation from earth. 
 
SERIAL PORT PARAMETERS 
Any communications program used to ‘talk’ to the 
logger must configure its serial port to: 
 
9600 baud, 8 data bits, 1 stop bit, no parity bit 
 
No ‘handshaking’ or ‘flow control’ is used. The logger 
does require that the DTR line is ‘active’ ie. +12V. 
This is the default for most comms programs anyway. 
 
INSTALLATION AND SETUP 
The logger needs to be ‘set up’ before use. You will 
need a PC running a communications program. Any 
comms program will do. Windows users can use 
HyperTerminal, which comes with Windows itself. We 
use our own term.exe. You may download this from 

http://kitsrus.com/zip/term.zip 
 
The zip file includes a detailed explanation of how 
to setup and use term.exe under W98. (Also 
reprinted in pages 9 and 10 below.) 
 
• Connect a PC to the logger via one of the serial 

ports. Use a 9-way, male-to-female ‘straight 
though’ cable.  

• Start the comms program and set the serial port 
parameters as described above.  Make sure the 
correct serial port is selected. 

• Power up the logger. A banner is printed showing 
the firmware version number and the amount of 
EEPROM memory installed. 

• Hold down the “PWD BYPASS” switch (S1) and 
simultaneously press the ‘Enter’ or ‘Return’ key 
on the PC keyboard. 

• A menu will be displayed, as follows: 
1. Download data 
2. Clear data 
3. Set date 
4. Set time 
5. Change password 
0. Exit 

• The first thing is option 2 - Clear data. This 
MUST be done so that the memory is initialized. 
Do not press option 1 before you Clear the data. If 
you do you will have to exit ‘term.exe’ & restart. 

• Then set the date - option 3. The current date will 
be displayed and you will be prompted to enter the 
new data. The date is entered as “mm/dd/yy” 
(including the ‘/’). 
Note: The logger does not check for valid dates. 
Eg. If you enter “15/66/01” it will accept it. 

• Set the time – option 4. The current time will be 
displayed and you will be prompted to enter the 
new time. The time is entered in 24-hour format as 
“hh:mm:ss” (including the ‘:’). All three fields of 
two digits must be entered to be accepted. 
Note: As with the date, the logger does not check 
for valid times. Eg. If you enter “29:77:99” it will 
accept it. 

• Set the password – option 5. You can use any 
letter, number or punctuation mark but it must be 
at least 4  characters long, up to a mazimum of 8 
characters.  
Note: Lower and upper case letters are treated as 
different characters. Eg. The lower case letter ‘a’ is 
not the same as capital ‘A’. 

• Now exit the menu using option 0. A “READY” 
prompt is displayed. 

Select the type of calls to log, as described next. 
 
TYPES OF CALLS 
The logger has an on-board switch (S2) that is used to 
select the type of calls to record.  
 
A call is defined as any time the phone line is looped 
(that is, the handset is picked up & the OFFHOOK  
LED is on.)   
 
Types of calls are defined as follows: 
1. Outgoing Calls Only 

These are calls where the handset is picked up and 
at least one digit is dialled. If no digits are dialled, 
no data is recorded. 

2. All Calls 
Data is recorded any time the line is looped, 
regardless of whether any digits are dialled or not. 
If no digits are dialled then it was probably an 
incoming call. 

 
The logger does not have ‘caller ID’ circuitry and is 
not able to record the phone number of incoming calls. 
 
TESTING 
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Use a telephone line cord to connect the logger to the 
telephone line via the ‘LINE’ connector on the back of 
the logger and connect a suitable power supply 
(12VDC plug pack).  
Once connected to the phone line we can test that it is 
actually recording calls. Connect a PC to the logger 
and run the comms program. This will enable us to see 
the ‘real time’ output. 
 
Now pick up the phone. The ‘OFFHOOK’ indicator 
should light and the current date and time printed on 
the PC screen. Dial a few digits – they should be 
displayed as they are pressed. Now hang up. The 
‘OFFHOOK’ indicator should go off and the date and 
time printed on the screen. 
 
Now we will check if it was recorded into memory. 
Press the ‘Enter’ or ‘Return’ key on the PC keyboard. 
You will be prompted for a password. Enter your 
password. You only have 5 seconds to start and 
between each character. If the password is correct a 
menu is displayed. Choose option 1 - Download data. 
The call you just made should be displayed there. 
 
Notice that the recorded format is slightly different to 
the ‘real time’ output. In the ‘real time’ output 
everything is printed as it happens ie the START 
date/time followed by the digits dialled followed by the 
END date/time. The recorded format has the START 
date/time followed by the END date/time followed by 
the digits dialled. This makes the data easier to read if 
simply making a printed copy. 
 
OPERATION AND USE 
The logger does not need a PC connected to log calls. 
A PC is only required to set or check the onboard clock 
and download any recorded call data. 
 
If the data memory becomes full the logger will not log 
any more calls. In this case connect a PC and download 
the data (see SAVING CALL DATA TO A DISK 
FILE). Once saved the memory MUST be cleared for 
the logger to continue logging further calls. 
 
NOTE: The logger will not log any calls while the 
menu is displayed. You must exit the menu (enter 
‘0’) to resume normal operation. 
 
WHAT IF I FORGET MY PASSWORD? 
In this case you will need to remove the lid from the 
logger and hold down the ‘PWD BYPASS’ switch 
before you press ‘Enter’ or ‘Return’. 
 
ADDING MORE MEMORY 
The logger uses up to 4 x AT24C128 EEPROMs for 
data storage. Each EEPROM is 16K bytes giving a 
total of 64K of memory. Only one EEPROM (16K) is 
supplied as standard with the kit. 
 
The memory is user upgradeable by simply ‘plugging 
in’ more EEPROM’s. Disconnect the power and 
telephone line and remove the lid. Insert the 
EEPROM(s) according to the following table: 

 
Memory Position 
16K MEM 1 
32K MEM 1, 2 
48K MEM 1, 2, 3 
64K MEM 1, 2, 3, 4 
 
WHAT DO THE LIGHTS MEAN? 
POWER indicates that power is connected to the 
logger. 
 
OFFHOOK indicates that the phone line is looped (in 
use). It will only indicate if the line was looped 
AFTER the logger was connected. If the line is already 
in use when the logger is connected then the indicator 
will be remain off until the NEXT time the line is used. 
 
The STATUS indicator has a number of meanings. It is 
used to indicate the amount of memory left for logging 
calls. When the memory capacity reaches 75% full the 
STATUS light starts flashing. When the memory is 
completely full the light is permanently ON and no 
more calls will be logged. 
 
The STATUS light is also permanently ON to indicate 
possible battery failure on the clock. If the battery has 
failed then the clock data may be corrupted or 
incorrect. In this case you will need to use the logger’s 
menu to check the date and time. Test the battery and 
replace if necessary. 
 
If both the STATUS and OFFHOOK lights are ON 
when the logger is powered up it means that the logger 
could not detect any EEPROM memory at all. If you 
connect a PC to the logger and run a comms program 
you will see the words “MEMORY ERROR” 
continuously printed. Check that there is an EEPROM 
in posistion ‘MEM 1’ or re-seat the chip if one is 
present. 
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DOWNLOAD DATA FORMAT 
The recorded call data is printed out in the following format: 
 
|---Start date and time---| |----End date and time----| |-digits dialled--| 
dd-mon-year hours:mins:secs,dd-mon-year hours:mins:secs,all numbers pressed 
 
The date is of the form “12-May-01” and the time is in 24-hour format as in “13:30:00” (1.30pm). Each data record 
(call) is terminated by a “carriage return/line feed” combination. 
 
SAVING CALL DATA TO A DISK FILE 
Now all the call logged data is sitting in MEM1 (and 
MEM2, 3 and 4 if present.) We want to get this data 
from these IC(s) into our PC. How do we do this?  
 
Answer: we download the data using a ‘comms’, 
communications, program running on a PC that 
‘captures’ the data to a disk file as it is displayed on the 
screen. All comms programs have a ‘data capture’ or 
‘logging’ function where everything displayed on the 
screen is also saved to a disk file. The file is a simple 
ASCII text file. W9x has its own comms program, 
Hyperterminal, built in and you can use this. But we 
use term.exe which is our own program and which can 
be downloaded from our website.  
 
You may download this from 

http://kitsrus.com/zip/term.zip 
 
The file includes a detailed explanation of how to 
setup and use term.exe under W98. . (Also reprinted 
in pages 9 and 10 below.) 
 
The following description assumes you are running 
term.exe. (Similar event sequences apply to all comms 
programs.)  
 
Connect to the logger with your PC and start term 
running by clicking on the term.exe icon. After the 
screen has appeared press ‘Enter’. You will be 
prompted for a password. Enter the password and a 
menu will be displayed. (The phone must not be in use 
– offhook LED lit - when you do this.) If you do not 
enter your password within 5 sec the software will 
return to ready mode and will log data. Hit Enter to get 
the password prompt back.  
 
After successful password entry you will get the Menu. 
Now turn on ‘data capture’ by pressing alt-L. You 
should be prompted for a file name to save to (term.log 
is the default). Hit Enter. LOG will appear on the 
bottom line of the display to show logging is on. Then 
choose option 1 – Download data. Hit Enter. All 
recorded data will be printed out (in the format 
described previously). When finished turn off ‘data 
capture’ by pressing alt-L again. Note that LOG 
disappears from the bottom line. All the data has now 
been saved to the disk file ‘term.log’. Finally, press ‘0’, 
press Enter -  the logger will exit the menu and return 
to normal operation. To exit term.exe hit alt-Q. Note 
logging must be turned off to allow you to exit from 
term.exe. 
 

 
Note that you cannot stop the scrolling of the data after 
you press ‘1’. The whole data in MEM1..4 is dumped 
to term.log in one go. You have to go to term.log with  
 
 
a text editor to look at the individual data lines or load 
it into Excel as described next. 
 
IMPORTING DATA INTO MICROSOFT EXCEL 
The data in term.log is in a format that can be easily 
imported into Microsoft Excel. First edited term.log to 
remove unwanted data from the start and end of the 
file. Once done the data can now be imported into 
Excel. 
 
The following step by step guide will show you how to 
import the file into Microsoft Excel. It has been tested 
using Excel 97 and 2000. 
 
1. Click on “File → Open” 
2. In the ‘Files of type’ box select ‘All Files (*.*)’ 
3. Browse to the saved data file, select it and click 

‘Open’ 
4. A ‘Text Import Wizard’ dialog box will appear. 

Under ‘Original data type’ select ‘Delimited’. 
Click ‘Next’ 

5. A second dialog box will appear. Here you can 
choose which delimiters to use to break up the file 
into columns. If you want the data and time to be 
one column then select ‘Comma’ only. If you want 
the date and time to be separate columns 
(recommended) then select both ‘Comma’ and 
‘Space’ as delimiters. A preview will show you 
how choosing each delimiter affects the file. Click 
‘Next’. 

6. A third and last dialog box appears. Here you can 
choose how Excel interprets each column of data. 
Select each column in turn and set the ‘Column 
data format’ to ‘Text’. Click ‘Finish’ when done. 

 
CALCULATING CALL DURATION 
Once you have imported the data we can use Excel’s 
date and time functions to calculate the length of each 
call. We can then sort the file into order starting with 
the longest duration call first. The data should have 
been imported in five columns labelled as follows: 
 

Column Data 
A Start date 
B Start  time 
C End date 
D End time 
E Digits dialled 
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The data should start in row 1. We will now create a 
column of data that is the duration of each call. 
 
1. Click on cell ‘F1’ 
2. Type in the following formula: 

=DATEVALUE(C1) + TIMEVALUE(D1) - 
DATEVALUE(A1) - TIMEVALUE(B1) 
This tells Excel to subtract the start date (A1) and 
time (B1) from the end date (C1) and time (D1). 

3. Click on cell ‘F1’ again 
4. From the menu select “Format → Cells” 
5. The “Format Cells” dialog box will appear. In the 

‘Number’ tab under ‘Category’ list select ‘Time’. 
Under ‘Type’ select ’37:30:55’. The call duration 
is now shown in “hours:minutes:seconds” and can 
span multiple days.  

 
We now want to copy this formula and formatting to 
the rest of the cells in this column down to the last data 
entry. 
 
6. Click on cell F1 again. This cell contains the 

formula and formatting information we need. 
7. Drag the fill handle over the cells to be filled. 

The fill handle is the small black square in the 
corner of the selected cell (F1). When you point to 
the fill handle, the mouse pointer changes to a 
black cross. 
 

The cells should now contain the duration of each call. 
 
Note: Some calls may span across midnight from one 
day to the next. In this case the end time will be earlier 
than the start time. Using the Excel DATEVALUE and 
TIMEVALUE functions allows the correct time 
duration to be calculated. 
 
SORTING THE DATA 
The data can be sorted in any order using any column 
as required. The following example sorts the data 
according to call duration (as calculated previously). 

 
1. Click on any data cell 
2. From the menu select “Data → Sort” 
3. The ‘Sort’ dialog box will appear. In the ‘Sort by’ 

box select Column F (the call duration column) 
and ‘Descending’ 

4. Click ‘OK’ 
 
The call data is now sorted by call duration with the 
longest call first. 
 
Of course you can sort the data in any order you like. 
Using the ‘digits dialled’ column will sort the data by 
phone numbers dialled, with all similar numbers 
grouped together. Sorting by “start time” will group all 
numbers dialled at a certain time of day. 
 
IF IT DOES NOT WORK 
Poor soldering (“dry joints”) is the most common 
reason for the circuit not working. Check all soldered 
joints carefully under a good light. Re-solder any that 
look suspicious. 

• Are all the components in their correct position on 
the PCB? 

• Are the electrolytic capacitors the right way 
round? What about the diodes and diode bridges? 

• Are the ICs the right way around? 
• Are any IC leads bent up under the IC body? 
• Is the regulator output = 5V? 
• Is it connected to the telephone line? 
• Is it connected to the right serial port on your PC? 
• Are you using a straight through serial cable? 
• Is the correct serial port selected in your comms 

program? 
• Is the serial port configured correctly? Is DTR 

active (+12V)? 
• Is an EEPROM inserted in position “MEM 1” 

(U4)? 
 
If you get the incorrect memory being shown then 
rearrange each 16K memory chip into other positions. 
 
WEB ADDRESS & EMAIL 
You can email us at peterhk@kitsrus.com if you have 
any problems or requests.  
 
Information on other kits in the range is available from 
our Web page at http://www.kitsrus.com 
 
For any technical problems or questions, contact the kit 
developer at frank@ozitronics.com 
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PART LIST – KIT 164 
Resistors (0.25W carbon film unless specified) 
470 .......................................R21................................. 1 
1K ........................................R10 15 16 24 ................. 4 
4K7 ......................................R17,18 ........................... 2 
8K2 ......................................R14................................. 1 
10K…………R9 11 12 13 19 20 22 23 25................. 9 
56K ......................................R3 1% metal film .......... 1 
68K ......................................R4 1% metal film .......... 1 
180K ....................................R8................................... 1 
220K ....................................R1,2................................ 2 
220K ....................................R5 1% metal film .......... 1 
270K ....................................R6 1% metal film .......... 1 
3M3......................................R7................................... 1 
Capacitors 
27pF ceramic .......................C10,11 ........................... 2 
10nF 63V Box Poly.............C1,2................................ 2 
100nF monobloc..................C3,4,7,8,12 .................... 5 
10uF 16V electrolytic..........C6,9................................ 2 
100uF 25V electrolytic........C5................................... 1 
Semiconductors 
1N4004 diode ......................D1,2 ............................... 2 
1N4148 ................................D3 .................................. 1 
WO2 bridge rectifier ...........B1,2................................ 2 
BC547..................................Q1,2 ............................... 2 
LED, 5mm Red....................L1,2,3............................. 3 
MT8870CE..........................U1 .................................. 1 
DTMF receiver 
MAX666, 5V regulator .......U2 .................................. 1 

Semiconductors (cont.) 
AT89C2051-24PC ..............U3 .................................. 1 
Pre-programmed with K164 firmware 
AT24C128...........................U4,5,6,7 ......................... 4 
Serial EEPROM   (Note: Only 1 supplied with kit) 
DS1307 Serial Time Clock .U8 .................................. 1 
6N138 or 139 optocoupler ..U9,10 ............................. 2 
Miscellaneous 
Crystal, 3.579MHz..............Y1  49US....................... 1 
Crystal, 20.2752MHz..........Y2  49US....................... 1 
Crystal, 32.768KHz ............Y3 tuning fork type....... 1 
Metal Oxide Varistor ..........MOV.............................. 1 
Phone connector, 6 way 4 pin      X1,2....................... 2 
DC Jack, 2.5mm..................X3 .................................. 1 
D9 connector .......................X4 .................................. 1 
PCB mounting, female 
Pushbutton switch ...............S1................................... 1 
SPDT Slide switch ..............S2................................... 1 
Lithium battery, 3V.............BATT……..not supplied 
CR2032 or equivalent 
Battery holder.............................................................. 1 
IC socket, 8 pin, for U2,4,5,6,7,8,9,10 ....................... 8 
IC socket, 18 pin, for U1............................................. 1 
IC socket, 20 pin, for U3............................................. 1 
LED clips, 5mm Black for L1,2,3 .............................. 3 
Self tapping screws for fixing PCB to case................ 4 
Plastic case, 130(W) x 100(D) x 30(H)mm................ 1 
PCB, K164 .................................................................. 1 
Set of front & rear panels............................................ 1 
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Some kits (K121, 122, 123, 164)  require a communications program to transfer data between the serial 
port on the PC and the kit. In Windows 9x there is a comms program called ‘Hyperterminal’ already 
built-in. In Windows 3.1x comes with the ‘Terminal’ comms program built in. There are many comms 
program you can download from software sites. 
 
Frank Crivelli (www.ozitronics.com) has written his own DOS-based comms program called ‘term.exe’.  
It is a simple, basic terminal program which does its job without a lot of ‘bells & whistles’. Also as of this 
moment he does not know how to write Windows software!  
 
You may download it from       http://kitsrus.com/zip/term.zip 
 
How to install ‘term.exe’ 
This is a detailed explanation of how I have installed ‘term.exe’ in my Windows 98 system. There are 
slight differences with Windows 95 and 2000 but it gives you an idea of how to do it. 
 

1. Unzip ‘term.zip’. You will get this file and ‘term.exe’.  
2. Move ‘term.exe’ to the same folder as Hyperterminal. 

       C:\Program Files\Accessories\Hyperterminal 
(I did this because sometimes I use Hyperterminal and all my hex files for programming firmware are 
in the same folder.) 

3. Right click on some blank space on the desktop and select "New → Shortcut".  
4. Click on the "Browse" button and find 'term.exe' on your hard disk in the above mentioned folder 
5. Click on it and select "open". Click "Next", "Next" then "Finish".  

 
You should now have an icon on your desktop. If you want to change the icon’s name then right click on 
it and select “Rename”. 
 

6. Right click on this icon and select "Properties". 
7. Click on the "Program" tab. 
8. Go to the end of the "Cmd line" box and type in " 9600" (you must include the leading space). If 

you are using COM2 then type " /2 9600" instead. Notice that the “Working” directory/folder is 
set to the same as the “Cmd line”. You can change this if necessary.  

9. Tick the “Close on exit” box. This will shutdown the DOS window when you quit ‘term.exe’. 
10. Click on the “Change Icon…” button if you want to change the icon associated with this shortcut. 
11. Click on the “Screen” tab and select “Full-screen”. 
12. Click "OK". 

 
To run ‘term.exe’ simply click on the desktop icon. 
 
Now see if you can communicate with the kit. 
 
Communicating with the Kit 
Each of our kits has a Menu in the kit Firmware. Power the kit, attach a straight-thru serial cable, then 
click on the term.exe icon. Or start term.exe, connect power and the serial cable. The order does not really 
matter.  
 
Now usually pushing the tact switch or, in the case of Kit 164, pressing Enter simultaneously, will bring 
up the Menu. But sometimes not. Do Alt-Q to exit the program, then click on the term.exe icon again to 
start it again. Almost always this restart will bring up the Menu after pressing the tact switch or hitting 
Enter. If not do the restart again. You should not need more than 3 restarts to capture the serial port. 
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Note F1 brings up the Help features. In particular, Alt-D goes to a DOS shell so you can do a dir *.* or 
dir *.hex to see what files are in the folder. Type ‘exit’ to get out of the DOS shell. Alt-L starts the 
logging to a file feature (needed for Kit 164.) When logging is on note ‘LOG’ appears on the bottom line. 
 
Programming with Kits 121 122 123 
I suggest you put the hex file you want to program into the same folder as term.exe. Then when you do an 
‘Alt-D’ followed by a ‘dir *.hex’ all the hex files will be in the same folder. You will not have to change 
folders using DOS commands (which an increasing number of people today do not know.) Exit the folder 
by typing ‘exit’ and hitting Enter. 
 
Put in the chip to be programmed. The Blank (B) and Erase (C or E – read the menu) commands are 
obvious. 
 
To send the hex file to the programmer hit P for program. You will be prompted ‘Send file now …’ Now 
hit Alt-S which is (press F1) ‘Send text file. Enter the hex file name. You will be prompted for the hex 
file name. Type it in then press Enter. The file will now be sent to the chip to be programmed on the 
programmer. You can do a Verify you will again be prompted to ‘Send File Now …’. Just hit Alt-S. The 
correct file name is remembered. Hit Enter and the file will be sent to be verified. 
 
Finally do the required Lock bit command. 
 
In the latest Kit 123 firmware there is a Q Bulk Programming feature built in which does C P L. You still 
have to do the Alt-S to send the file to the Programmer. 
 
Contact Us 
You may contact the term.exe writer at  frank@ozitronics.com 
 
If you have suggestions on how to improve this documentation email me at   peterhk@kitsrus.com 
 
August 9, 2001. 

- - - - - - - - - - - - - - - - - 
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One out of the 4 memory 
chips is inserted.  


